
Adding Drum Fills
Drum fills can be used to add variety and texture to parts, to create breaks and drum solos, and to serve 
as transitions from part to part. To add a drum fill to a measure do the following:

1. Move the cursor in the Measures Window to the measure where you want to add a drum fill. (Move to 
measure 4 for this example)

2. Click and hold down the right mouse button and a pop-up menu will appear.

3. While holding the right mouse button down, drag the highlighted menu bar downward and release it 
on the Long Drum Fill selection.

The JAMMER will now display a thin blue bar at the top of the measure to show you that a drum fill will be 
composed there the next time you click on the COMP button. Placing the drum fill mark there does not 
compose the drum fill. It is just a marker that lets the musicians know to compose a drum fill there when 
you click on the COMP button.

Compose bars 1-4 a few more times now by clicking on the COMP button and listen to the different drum 
fills that get composed. When you compose a piece that sounds cool to you, move on to the next section.
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Adding Transitions to the Groove
Not only can you create and control grooves in the JAMMER, you can also control groove transitions. 
Transitions are short runs which can be inserted in the middle of a groove to spice up the groove or can 
be used to create movement into chord changes. To get a feel for transitions, do the following:

1. Double left click on the Major Scale field in the Scales box to select it as the only scale choice.

2. Double left click on the Blues Hold field in the Styles box to select it as the only fundamental style 
choice.

2. Double left click on the Blues Med field in the Transitions box to select it as the only transition type.

3. Click on the MORE button to go to the Melody Controls screen. At this point, when you compose, you 
should be hearing just the Slow groove notes of the main style.

4. Inside of the Transitions box in the Melody Control screen, set the Into Chords % field to 100, set both 
the Min Length field and the Max Length fields to 6 and set the Threshold field to 4. This instructs the 
JAMMER to do a transition 100 percent of the time going into chord changes, to make the transitions 
6 triplet 8ths long, and to only do a transition if there is 4 triplet 8ths of room to do one.

5. Now compose a few times by clicking on the COMP button at the bottom of the screen and listen as 
the JAMMER plays the main groove with slow notes and does a triplet 8th type transition into each 
chord change.

6. Leave the 100 by Into Chords and place a 50 by Into Notes %. This will cause the JAMMER to do 
extra transitions 50 percent of the time leading into the notes of the main groove causing the part to 
get even busier. Compose a few times to hear the extra transitions being added.

7. Now go back to the Melody Style screen by clicking on the MORE button at the bottom of the screen.

8. Compose a few more times to get used to the medium transitions that you are hearing and then 
double left click on the Medium+ field in the Transitions box to hear a slightly faster type of transitions 
being added to the slow groove.

9. Ok, now you’re ready to really blend some variables together. Leave the 20 by Medium+ and double 
right click on Medium, Blues Med and Blues Shuffle in the Transitions box to blend four types of 
transitions together. Also double right click on Chord Notes, Pentatonic, Minor Blues, Major Blues and 
Chromatic in the Scales box and Blues 8ths in the Styles box. Now compose a few times to hear the 
blend of all these variables. It’s probably obvious by now that the JAMMER can create billions of 
different parts for you    - all under your control!
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Advanced Tutorial
(Pro Version Only)
Each band style in the JAMMER is made up of a selected group of individual musician styles. These have 
been setup at the factory for you, but they are just the beginning of what you can do with the JAMMER. 
With the Professional version of the JAMMER, in addition to loading band styles you can also modify 
band styles, create new band styles, bring new musicians into a style and change the style of each 
musicians independently of the others.

Choosing Your Musicians
The Player field in the Tracks Window allows you to choose what type of composer will be jamming on 
each track. To change the composer selection for a track either double click on the Player field, right click 
and drag on the Player field or move your cursor to the Player field and press Enter. The composer type 
choices are Bass, Rhythm, Melody, Harmony, Duplicator, Kick, Snare, and Percussion. Normally the 
Bass, Rhythm, Melody and Harmony Composers are used on the instrument tracks (1-27) and the Kick, 
Snare and Percussion Composers are used on the drum tracks (28-55).

Once you have chosen the composer type for a track, you can edit the style for its musician by double 
clicking on the track’s Edit Style field or by moving your cursor to the Edit Style field and pressing Enter.
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Blending Fundamental Styles
Now that you have learned how to preview individual styles let’s blend a few styles together:

1. Double left click on Blues 8ths to preview this one style. Notice that this style does not pause or hold 
but continues to jam with a triplet 8th feel.

2. Double left click on Blues Hold to preview this one style. Notice that this style holds a lot of notes and 
does not jam around like the Blues 8ths style.

3. Double right click on Blues 8ths to place a 20 by it creating an equal blend of Blues Hold and Blues 
8ths.

4. Now click on COMP at the bottom of the screen to hear a melody composed using the blend of styles. 
Compose a few times to hear the randomness in the blend. 

5. Leave the 20 by Blues 8ths and change the 20 by Blues Hold to a 10. This will create a blend with 
twice as much Blues 8ths as Blues Hold.

6. Now click on COMP at the bottom of the screen to hear a melody composed using the blend of styles. 
Compose a few times to hear the randomness in the blend.

You can blend as many styles together as you like using the weights of your choice. You can use values 
like 1,2, 3, 4, 5, 7, 10, 18, 20, 37, or 45 to create whatever type of blend you are looking for. Remember to 
compose a few times to give the yourself a fair sampling of the blend.
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Choosing and Blending Scales
The Melody Style dialog box also allows you to choose individual scales and blend different scales 
together. For notes with an extended duration, the JAMMER will force the use of chord tones for these 
notes rather than using the designated scales to avoid having accidentals (notes out of key) or weaker 
notes being held for an extended time. For this reason it is best that we preview the scale choices with a 
timing style that moves along and does not hold a lot of notes such as the first custom pattern. To preview 
some scales do the following:

1. Double left click on the usage weight field to the left of the first (top) custom pattern. The JAMMER 
will now play the major scale up and down using solid triplet 8ths.

2. Now double left click on each of the scale choices at the top right of the screen and you will hear the 
JAMMER play the various scales up and down using solid triplet 8ths.

3. Place a 100 by Scale Change %. This will allow the JAMMER to potentially change scales on a note 
by note basis.

4. Now place a 20 by Chord Notes and a 20 by Chromatic, and then click on the COMP button to hear 
the blend.

Of course you can blend as many different scales together as you like using the usage weights of your 
choice.
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Chord Entry Window
Another way to enter chords is to use the Chord Entry Window. It allows you choose from a list of all the 
different types of chords supported by the JAMMER. This window also allows you to preview or hear what 
a particular chord sounds like. To enter a chord using the Chord Entry Window do the following:

1. Move the cursor in the Measures Window to the chord position where you want to enter or edit a 
chord.

2. Click on the Edit Chord tool: The JAMMER will then display a list of all supported chords.

3. Click on the root of the chord at the top of the dialog box and then click on the chord type below. 
The JAMMER will fill this chord in for you in the Measures Window.
4. If you want to preview a chord (see what a particular chord sounds like) click and hold down the 
right mouse button on either the chord root or the chord type and the chord will be sustained until you 
release the mouse button.
5. If you want to work on another chord in a different position in the Measures Window you can use the 

mouse to choose a new chord position while the Chord Entry Window    remains open.

6. Click on the Close button to close the Chord Entry Window.
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Composing Made Easy
  

To have the JAMMER compose music 
for you from the main screen, simply 
click on the COMP button.

Any tracks that are set to Comp in the Action field in the Tracks Window will have new parts written to 
them in the measures designated by the punch in and out values. Any tracks that are set to Eras in the 
Action field in the Tracks Window will have all notes erased in the measures designated by the punch in 
and out values. Any tracks set to Keep in the Action field in the Tracks Window will be left unchanged. 
These action fields are setup for you when you load a band style. This architecture allows you to work on 
any combination of tracks and measures you like. You could compose parts on 10 selected tracks over 8 
selected measures all at once or you could focus in and compose just one part on just one track for a 
single measure.

In our current example, measures 1-4 are selected for composing and looping. When you click on the 
COMP button, the JAMMER will compose measures 1-4 and then replay them for you in a loop. You can 
compose a few times by clicking on COMP to hear some parts being created for your introduction.
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Configuring MIDI Channels
If your MIDI channels need to be setup differently than the way they are set in the default mix you will 
need to create a custom mix file to accommodate your setup. If you have a Sound Blaster or your setup is 
totally GM or GS compatible then you may skip to the next section.

To create your own default mix, first select Load Mix from the Styles menu. Then select the mix file 
entitled GS and press Enter or click on the Ok button. Now make your channel changes to accommodate 
your studio setup. To save your new mix select Save Mix from the Styles menu, enter a name for your mix 
file and then press Enter or click on the Ok button to save and exit.

Now that you have a new mix file, you need to 
let the JAMMER know you want it loaded 
automatically when you start the program. To 
do this select System Options from the 
Devices menu. Now tab down to the field 
called default mix, enter the name of your mix 
file you just saved and then press Enter or 
click on the Ok button. Now the JAMMER will 
automatically load your mix file when the 
program is started.
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Configuring the JAMMER
If your MIDI devices are General MIDI (GM) or General Standard (GS) compatible, then your drum kit and 
instrument patches are already setup for you and you may skip the next two sections.

In order to create, sequence and play back beautiful jams, the JAMMER needs to know a little bit about 
the MIDI devices that you plan to use. The JAMMER keeps drum key numbers and synthesizer patch 
information in files which may be loaded and reconfigured from within the JAMMER.
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Welcome to the JAMMER for Windows version 2.0 tutorial by Soundtrek.

Get ready for the ultimate experience in MIDI software. The JAMMER provides you with a 256 track MIDI 
sequencer, a complete studio interface plus an array of studio musicians ready to write parts, record 
tracks and jam with you. This tutorial will help you get the JAMMER setup for your studio and then explain 
the basic architecture of the JAMMER showing you how to compose and produce parts along the way. 
These exercises build on one another and are context sensitive so it is best to go through the entire 
tutorial at a single sitting. The tutorial is a hands on learning experience and only takes about an hour or 
two. It will help you get the most out of the JAMMER in the least amount of time.

Tutorial Hints
For a quick tour through the JAMMER, select Getting Started from the Help menu.

If you want the tutorial to stay on top of all other windows, click the On Top button at the top of this help 
window. Click the On Top button again to restore tutorial to normal windowed operation.

To proceed through the tutorial, use the browse buttons located at the top of this help window. Proceed to 
the next topic by clicking the >> button. You may move to the previous topic by clicking the << button.

This tutorial is designed to acquaint you with the basic features and operation of the JAMMER. It is not 
intended to be general reference. For detailed reference on all of the JAMMER's features, open the 
included help file from the Program Manager.

Let's Begin
JAMMER Tutorial
Advanced Tutorial (Professional Version Only)
List of Topics



Controlling Playback
Playback, recording, and composing in the JAMMER can be controlled by the row of transport control 
buttons in the Status Windows.

Click each button below for its description.

Next Topic



Copying Chords and Lyrics
Most popular songs have parts repeated through out the song such as verses, refrains, and choruses. 
Once you have entered the chords for a part, there is no need to type the same chords in again and 
again. Now that we have some chords and drum fill markers typed in for our first verse we can copy these 
measures to create another verse. To copy the verse we just entered do the following:

1. Select the measures you want to copy by clicking the mouse down on the first measure you want to 
copy and then dragging the mouse to last measure you want to copy before releasing the button. 
(Select measures 5-16 for this example)    The selected measures will appear inverted or black to 
show that they are selected. The Measures Window will automatically scroll for you if you go down 
below or up above the measures currently displayed.

2. Click the mouse button down anywhere inside of the selected measures and drag the measures 
down to the measure where you want them to be copied (measure 17 for this example). The 
Measures Window will automatically scroll for you if you go down below or up above the measures 
currently displayed.

3. The JAMMER will now display the Copy Song Measures dialog box, allowing you to review or change 
the settings before actually doing the copy function. The measures you selected and the place you 
dragged them to should already be filled in. The screen should read:

Copy Song Measures

From Measure:    5 Thru: 16

To Measure: 17.

Make sure these values are correct. If these values are correct then move ahead to step 4 but do not 
click on Ok yet. If they are not correct then click on Cancel and try the select and drag operation again 

until you get it right.

4. Set the Repeat field to 3 so that it says Repeat 3 Times. This will cause 3 copies of the selected 
measures to be inserted in front of measure 17.

5. Click on OK or press Enter to complete the copy operation.

Now that you have copied the 12 bar verse a few times it would be a good idea to change the label (lyrics 
field) on the second 12 bar verse to "Verse 2", the label on the third 12 bar verse to "Verse 3", and the 
label on the fourth 12 bar verse to "Verse 4".
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Creating A Drum Solo
Now, let’s create a drum solo by using a drum break style with some long drum fills. To create the drum 
solo do the following:

1. Set the Punch In and Punch Out to measures 29-40.

2. Click on the Load Style tool to open the Load Band Style dialog box.

3. Select the style:

Jazz Swing Fast Break | Drums Straight / Stop Bass (1)

4. Click on OK to load the style.

5. Remove the short drum fill on measure 30 by clicking the right mouse button down on measure 30. A 
pop-up menu will appear. Drag the highlighted bar in the pop-up menu down to the Short Fill selection 
before releasing the button.

6. Place a long drum fill on measures 31,32,35, 36, 38, 39 and 40.

7. Compose until your heart is content.
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Creating A Verse With a Melody Player
Now, let’s compose a verse with a melody being played throughout it. To create this verse do the 
following:

1. Set the Punch In and Punch Out to measures 17-28.

2. Click on the Load Style tool to open the Load Band Style dialog box.

3. Click to clear the X by the Exclude Melody field in the bottom right part of the Load Band Style dialog 
box. This will cause the style to be loaded with a melody player if one is listed with the style.

4. Select the style:

Jazz Swing Fast Groove | Piano Sync Cut / Jazz Bass (2) Piano Lead

5. Click on OK to load the style.

6. Now compose until your heart is content.
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Creating A Verse With a Melody and Harmonies
Now, let’s compose a final verse with a melody being played with a two part harmony. To create this verse 
do the following:

1. Set the Punch In and Punch Out to measures 41-52.

2. Click on the Load Style tool to open the Load Band Style dialog box.

3. Make sure the X is cleared by the Exclude Melody field in the bottom right part of the Load Band Style 
dialog. This will cause the style to be loaded with a melody player if one is listed with the style.

4. Select the style:

Jazz Swing Fast Groove | Piano Sync Cut / Jazz Bass (2)    Piano Lead

5. Click on OK to load the style.

6. Click on the Electric Piano tool on the top tool bar to take you to the electric piano track (track 14 in 
the Tracks Window).

7. Click and drag with the right mouse button on the Action field of track 14 to set it to Comp (it is 
currently set to Eras). This will cause the measures in the punch zone on track 14 to be composed 
when you click the COMP button. 

8. Click and drag with the right mouse button on the Player field of track 14 to set it to  Harm (the 
harmony composer). This will select the Harmony Composer to write a part on track 14.

9. Double click the left mouse button on the Edit Style field of track 14 and the Harmony Composer 
control screen for track 14 will be displayed.

10.     Click once on the Reset button at the bottom right of your screen to reset all of the 
values in this screen to a default state.

11. Click once with the left mouse button on the square button below the number "1" to enable Voice 
1 of the Harmony Composer.
12. Double click the right mouse button on the field with a zero in it just below the Voice 1 enable 
button and to the right of the voice selection "3rd Scale Tone Up". This will put a 20 in this field causing 
Voice 1 of the Harmony Composer to use the third scale tone up of the major scale from the source tone.

Note: The value of 20 is a relative weight used to show how much of the interval "Third Scale Tone 
Up" is to be used relative to other intervals for the first harmony voice. These relative weights allow 
you to blend intervals together based on the relative weights placed by each. Since all the other 
intervals in the column below Voice 1 have a zero in them, the interval Third Scale Tone Up will be 
used exclusively since it is the only choice. The number 20 is just a good arbitrary medium sized 
number    to start with when blending things together in the JAMMER. The double right mouse click is 
just a quick way to enter a 20 in a field.

13. Click once with the left mouse button on the square button below the number "2" to enable Voice 2 of 
the Harmony Composer.

14. Double click the right mouse button on the 2nd and 6th fields just below the Voice 2 enable button. 
This will place a 20 by 3rd Scale Tone Down and a 20 by 1 Chord Tone Down for voice 2. This will 
cause voice two of the harmony to be an equal random blend of    tow different types of harmony, 3 
scale tones down from the source tone in the major scale and 1 chord tone down from the source 
tone based on the current chord in the Measures Window.

15. Click once on the Source Track button at the top right of your screen to open the list of available 
source tracks, and then double click on track 003 Acoustic Grand to select it as the source melody 
track. This is the melody track from the style we loaded previously. (You can tell it is the melody track 
in the Tracks Window because the Player field of track 3 is set to Melo and the Action field is set to 
Comp). 

16. Now set the velocity offset for Voice 1 and Voice 2 at the bottom of your screen to -10. This will cause 



the harmonies to be a little softer than the source melody tones. Of course you can mix these any 
way you like to get whatever effect you desire.

17. Now you’re ready to compose a 12 bar section with a melody and a two part harmony where one of 
the harmony voices is a static tertian harmony and the other is a blend of tertian and chordal 
harmony. Wow!

18.     Click on the COMP button at the bottom of your screen and away you go. Feel free to 
experiment in this screen for a minute by removing and or adding and blending harmony voices. Each 
time you make a change, you need to click on the COMP button to hear a part being composed using 
your new settings.

19. When you are done having fun with harmonies, click on the Ok button to store your settings and 
return to the Tracks Window.
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Creating A Verse Without a Melody Player
Now that we have an introduction, we can begin work on a verse. In most cases, it is important to hear 
how one part leads into another so that you can insure that you have smooth transitions between parts. 
For example to hear how the introduction leads into the first verse as we are composing the first verse, do 
the following:

1. Set the Punch In and Punch Out to measures 5-16.

2. Click the right mouse button down on measure 1 and drag the highlighted bar down to Loop From 
before releasing the mouse button. This will cause the JAMMER to start playback at measure 1 after 
composing measures 5-16.

2. Click on the Load Style tool to open the Load Band Style dialog box.

3. Click to place an X by the Exclude Melody field in the bottom right part of the Load Band Style dialog. 
This will cause the style to be loaded without a melody player. 

4. Select the style:

Jazz Swing Fast Groove | Piano Sync Cut / Jazz Bass (2)    Piano Lead

5. Click on OK to load the style.

6. Put a short drum fill marker on measures 10, 12, and 15, and put a long drum fill marker on measure 
16.

7. Now compose until your heart is content.

Sometimes you may need to go back and recompose a part like the introduction after composing the 
verse to get the intro to lead into the verse the way you want it to. You can build a lot of strength into your 
songs by massaging and reworking the various parts as you go to insure the whole thing flows smoothly.
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Deleting Unused Measures
Measures 60-140 will not be used for our example so they can be deleted. To delete these unused 
measures do the following:

1. Select the measures you want to delete by clicking and dragging the mouse over the measures. 
(Select measures 60-140 for this example)

2.     To delete the selected measures, press the Del key on your keyboard or drag the selected 
measures to the Trash Can tool at the lower left of your screen.

3. The Delete Song Measures dialog box will be displayed and should have the proper values 
already filled in for you. The dialog text should read 

Delete Measure: 60 Thru: 140.

If these values are correct then click on OK. If they are not correct then click on Cancel and try the 
select and delete operation again until you get it right.
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Drum Kit Configuration
To see a list of the available drum kit configuration files select Load Drum Kit from the Devices menu. To 
select a drum kit configuration file, move the highlighted bar to the desired filename and then press Enter 
or click on the Ok button.

If there is no drum kit file which matches your MIDI drum device then you can create one by selecting Edit 
Drum Kit from the Devices menu. You will then see a full screen of drum key assignments.

There are 60 pieces in the JAMMER drum kit. To edit a drum number, double click the mouse on the drum 
name or move the cursor to the drum name and press Enter. When you are through editing drum 
numbers, click on the word File at the top left of your screen (or press Alt+F) to open the File menu, and 
select Save and Exit to save your new drum key assignments. The JAMMER will open a dialog box 
allowing you to save your drum setup under the name of your choice. After you save your drum setup, the 
JAMMER will remember it's name and will automatically load it the next time you start the program.
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Editing an Individual Musician Style
To get setup for this section do the following:

1. Load the band style:

Blues Upbeat Groove Piano Syncopated/Blues Bass (1) Piano Lead

2.     Enable the Progression Composer by clicking the right mouse button on the Progression 
Composer tool until it says COMP beneath the chord diagram.

3. Set your Punch and Loop measures to 1-8.

4.     Compose a few times until you find a progression that you like and then set the 
Progression Composer back to KEEP by right clicking on the Progression Composer tool again until it 
says KEEP.
5. Select Keep All Tracks from the Util menu.

6. Set the Action field of track 3 (the second Piano) back to COMP. This will cause all of the parts you 
just composed to be kept the same while you compose new melodies on track 3.

7. Select Edit Style in the Tracks Window on track 3. Since track 3 is set to be a Melody Composer, the 
JAMMER will open the Melody Style dialog box.
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Endings
There are many different ways to end a song. One common way to end a song can be described as being 
made up of three pieces: the pre-ending, the ending hold, and the ending stop. The pre-ending is usually 
some riff or break type part that leads you into the final chord or ending hold. At this point you can let the 
last chord hold and fade out or you can bring it all to a sudden stop with an ending stop or a stinger.

To create a pre-ending for our example do the following:

1. Select measures 1-4 and then drag them down and drop them on top of measure 53. The Copy Song 
Measures dialog box will be displayed and should read

Copy Song Measures

From Measure: 1 Thru: 4

To Measure: 53.

If these values are correct then click on OK. If they are not correct then click on Cancel and try the 
select and drag operation again until you get it right.

2. Type the word Pre-Ending into the lyrics field.

3. Set the Punch In and Punch Out to measures 53-56.

4. Click on the Load Style tool to open the Load Band Style dialog box.

5. Select the style:

Jazz Swing Fast Pre-Ending | Piano Syncopated / Simple Bass (1)

6. Click on OK to load the style.

7. Compose a few times to find a part you like.

You should now have some blank measures at the end of the song starting with measure 57. Type the 
chord Bbmaj7 in the first position of measure 57 and enter the word "Ending" into the lyrics field for 
measure 57. We will let the final ending ring out for three measures up through measure 59.
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Enhancing Your Drum Solo
To add a little change of pace to our drum solo let’s recompose the last four measures of the drum solo 
with a variation of the band style. To create this change in feel do the following:

1. Set the Punch In and Punch Out to measures 37-40.

2. Click on the Load Style tool to open the Load Band Style dialog box.

3. Select the style:

Jazz Swing Fast Break | Drums Straight / Stop Bass (2)

4. Click on OK to load the style.

5. Compose until your heart is content.
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Entering Lyrics or Comments
If you have lyrics or comments that you wish to enter in your song you can place them under any 
measure. To enter lyrics or a comment, do the following:

1. Move the cursor in the Measures Window to the measure where you want to enter some text. (Go to 
measure 1 for our example)

2. Press the letter ‘L’ (unshifted or shifted) and the Edit Lyrics dialog box will appear.

3. Type in the desired comment or lyrics and press Enter. (Type in the text "Intro" for our example)
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Fundamental Styles and Usage Weights
The names in the first two columns on the left in the top half of the Melody Style screen represent the 
fundamental melody styles. These control the timing of the notes in the main groove of your melody. Each 
different type of composer in the JAMMER has a different set of fundamental styles to choose from. For 
instance, while the Melody Composer has fundamental style selections like Slow, Slow Cut, Medium and 
Medium Cut, the Bass Composer has fundamental style selections like Straight Pop, Easy Blues, Funk 
Master, Walking Jazz and Country, and the Rhythm Composer has fundamental style selections like 
Straight Chords, Syncopated Chords, Reggae, Funk and Pick Slow.

The numbers to the left of each of the fundamental style names represent how much that particular timing 
style is to be used. These weighted values are not probabilities or percentages but are usage weights 
which are relative to the weights of other items in the same group. In other words, if you have a value of 
10 by Slow and a value of 5 by Slow Cut the JAMMER will use Slow timing patterns twice as much as it 
will use Slow Cut patterns to compose your part. If you have a value of 10 by Slow and a zero by all other 
fundamental style selections then    the JAMMER has no choice but to use just Slow timing patterns to 
compose your part. You can blend as many fundamental styles together as you like to create a part.

You'll see the number 20 used a lot as a usage weight in the    tutorial and in the style files. The number 
20 is a good average weight to use since it is not too big and not too small. If you have 20 by a field and 
you want to blend in half as much of another field, put 10 by the other field. If you want just a tiny bit of 
another field blended then put a 1 or a 2 by the other field. If you want twice as much of another field you 
can place a 40 by the other field. There is nothing magic about the number 20. Its just a good starting 
point that leaves your options open for adding heavier and lighter weights to other fields.
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Getting In The Swing Of Things
Now that you've had a quick tour of the studio, let’s listen to the demo song WELCOME and make sure 
everything is hooked up right. If your machine is slower than a 386 DX 25 MHZ you may need to turn off 
the tape deck and LED animation before starting playback as these features require more processing 
power. Alternatively, you may keep the animation enabled and try running Windows in standard mode 
(WIN /S).

To disable tape deck and LED animation, select Preferences from the Window menu and clear the check 
boxes labeled Enable Track LED’s and Enable Tapedeck Animation by clicking on the checked items.

To start playback of the song, click on the Play button, press F2 or press the space bar. If 
everything is set right you should hear a drum roll start the song followed by a jammin jazz / blues swing 
beat with a burnin sax on top of it all. Welcome to the JAMMER!

You can stop playback by clicking on the Stop button or by pressing the space bar.
If the drums or instruments do not sound like you think they should then you probably need to go back 
and check your drum, patch and mix settings. Some MIDI devices can be a real challenge to setup so 
make sure you read the documentation carefully. If you have read your sound module documentation 
thoroughly and still can't get the sounds to come out right, you may need to contact Soundtrek technical 
support for some assistance.
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How About the Other Composers?
For each different type of composer that you select on a track, you will get a different type of style screen 
and control screen when you edit the style for that track. Each of the different composers have different 
fundamental style selections, but the layout and operation of the control parameters are very similar from 
composer to composer. To get a good understanding of each composer, do like we did here with the 
Melody Composer and limit the variable interaction to start with until you get a good feel for each control. 
Then start experimenting with blending fundamental styles and controls. Pretty soon you will be able to 
create just about any type of parts you want.
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JAMMER Tutorial
Let's fire it up. Double click the left mouse button on the JAMMER icon in the JAMMER Program Manager 
group. The JAMMER will initialize itself, display the title screen followed by the main screen and then give 
you a chance to select a mix file that matches your sound card or module. A mix file sets the patches, 
banks, channels, levels, velocities, pans, reverb and chorus settings to make your system sound it’s best. 
If you see your sound card or module listed, choose the "Standard" mix file for your device. If your device 
is not listed then choose the General MIDI Standard mix file.
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Just a Few More Chords To Go
Next let’s enter some chords to create a 12 bar verse. First enter the words "Verse 1" in the lyrics field of 
measure 5 and then enter the following chords into the first position of the specified measures starting 
with measure 5:

( 5) Bbmaj9 ( 6) ( 7) Dm7b5 ( 8)

( 9) G13 (10) (11) Gm9 (12) F9

(13) Bbmaj7 (14) G13 (15) Gm7 (16) F7#5
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Limiting the Variables
The best way to get a feeling for how the Melody Composer writes parts is to keep things simple at first 
and then start adding more variables later. In order to simplify things do the following:

1.     Click the Reset button. This will zero out all of the fields on this screen.

2     Click the More button. This will take you to the Melody Controls screen.
3. Click the Reset button. This will set the fields to a default state.
4. Click the More button. This will take you back to the Melody Style screen.
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Load the song Welcome
The JAMMER will now display the main windows for you in the tiled format. It will also display the on-line 
tutorial in a dialog box in the top right of the screen. The printed tutorial is more extensive than the quick 
start on-line tutorial so click the Close button in the on-line tutorial dialog to close it for the time. You can 
reopen it later by clicking on Getting Started under the Help menu at the top right of the screen.

Now select Load Song from the File menu and the JAMMER will display the Load Song dialog box.

Locate and select the song called WELCOME and then press Enter or click on the Ok button to load the 
song and exit the dialog box. You should now see the song WELCOME loaded into the JAMMER with 
some highlighted tracks in the Tracks Window and some chords in the Measures Window.
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Main Windows
The JAMMER has two main windows for viewing your songs, the Tracks Window and the Measures 
Window. The default window layout for the JAMMER is the "tiled" layout where the two main windows 
share the screen and one is displayed above the other. This is a powerful view because you can see track 
data as well as your chord progression at the same time. When you click your mouse within one of these 
windows, the title bar of the window will become highlighted and that window becomes the active window. 
Keys typed on the keyboard are sent to the active window for processing. You can toggle the active 
window by pressing Ctrl+W or by clicking on the Swap Window tool on the side tool bar.

In some cases you may want to see a lot of tracks or a lot of measures all at one time. In this case you 
can maximize a window so that it takes up all of the available window space. Let’s maximize the Tracks 
Window and take a look at the track layout. Click on the maximize button for the Tracks Window (the little 
black triangle pointing upward in the top right corner of the Tracks Window). The JAMMER will now 
display the Tracks Window in it's maximized form.
When the Tracks Window is maximized like this you can swap back and forth between it and the 
Measures Window by pressing Ctrl+W or by clicking on the Swap Window tool on the side tool bar. Click 
on the Swap Window tool to swap to the Measures Window and then click on it again to bring you back to 
the Tracks Window.
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Measures Window
  

Click on the Swap Window tool on the 
side tool bar to swap from the Tracks 
Window to the Measures Window. 
You should now see the Measures 
Window in its maximized form.

The Measures Window allows you to view and enter chord progressions, lyrics and drum fills. Each 
measure is displayed as a single stave with the measure number and chord names above it.

The blue rectangle to the right of the number '1' above the first measure is the Measures Window cursor 
and can be moved about using the arrow keys or by clicking on a measure with your mouse.

A long thin blue line under the top staff line of a measure represents a long drum fill A short thin blue line 
under the top staff line of a measure number represents a short drum fill.

A green vertical arrow under a measure shows the Punch In location (the measure where composing or 
recording will begin) and a red vertical arrow under a measure number shows the Punch Out location (the 
measure where composing or recording will stop). The measure numbers for measures within the punch 
zone are displayed in red letting you know those measures will have new parts written to them when you 
click on the COMP button.

A double bar with two dots at the beginning of a measure shows the Loop From location (the place where 
playback will loop back to when looping is enabled).

If your chord progression is very sparse (very few chord changes) you may want to increase the number 
of measures per line so that you can see more measures in the same sized window. Press the number '4' 
key on your keyboard and the JAMMER will display 4 measures per line. If you are using the keypad on 
the far right of your keyboard, Num Lock will need to be on. If your chords are very dense (a lot of chords 
per measure with long chord names) then you may want to see one measure per line. Press the number 
'1' key and the JAMMER will display one measure per line. The JAMMER can display 1,2,3,4,5,6,7,8 and 
9 measures per line. Set your measures per line back to 2 before continuing.

If you are not concerned with details 
like time signatures and drum fill 
placement and you want to see the 
most measures possible at one time 
on the screen, the JAMMER can pack 
the Measures Window for you. Click 
on the Pack tool on the side tool bar 
and the JAMMER will display the 
Measures Window in packed mode.

Click on the Pack tool again and the JAMMER will return to the unpacked measures view.
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Melody Movement
Now that we have scales and timing under control, we need a way to control the direction and flow of the 
parts we are composing. The three controls Jump %, Change Direction %, and Cascade % are 
probabilities from 0 to 100 percent which allow you to control the direction and flow of your melodies. To 
hear a good example of these variables in action do the following:

1. Click the Ok button to exit the Melody Style dialog box.

2. With your cursor still on track 3, click on the word Solo at the top left of the main screen to put track 3 
in solo mode. Track 3 will be the only track displayed in white and will be the only track heard when 
playback is started. This will help us concentrate on the melody part.

3. Double left click on the Edit Style field for track 3 to continue editing the style for the melody. 

4. Double left click on the Major Scale field in the Melody Style screen to select it as the only scale 
choice and then click on the MORE button at the bottom of the screen to go to the Melody Controls 
screen. Click the Stop button if you wish to stop playback.

6. Set the Low Note field in the Note Range box to 50 to give us a much wider range in which to observe 
the melody’s motion.

7. Click on COMP once and you should be hearing just the piano run up and down the major scale 
sequentially.

8. Double right click on the Jump % field in the Melody Movement box to place a 20 there. Now, 
compose a few times. You will hear the piano play the major scale and jump (skip notes in the scale) 
every now and then. The 20 means there is a 20% probability that the JAMMER will jump on any 
given note in the melody.

9. Single right click on the Jump % field in the Melody Movement box to place a 0 there, double right 
click on the Change Direction % field to place a 20 there and then compose a few times. Now you will 
hear the piano play the major scale without skipping any notes but it will change directions (ascending 
or descending) every now and then. The 20 means there is a 20% probability that the JAMMER will 
change directions on any given note in the melody.

10. Single right click on the Change Direction % field in the Melody Movement box to place a 0 there and 
then put a 100 by the Cascade field. Also put a 100 by the Scale Pattern % field in the Repeat box on 
the left side of the screen. Now you are setup to hear the JAMMER play the major scale using a 
single cascading pattern. The 100 by Cascade tells the JAMMER to use a cascading pattern such as 
up one scale tone, up one scale tone, down one scale tone. The 100 by Scale Tone Pattern % in the 
Repeat box tells the JAMMER to lock on to the scale tone pattern it selects and use it repeatedly.

11. Compose a few times and you will hear the melody cascading up and down, traversing the note 
range. Every time that you compose, the JAMMER will choose from many different scale tone 
patterns.

12. Now for the blend! In the Melody Movement box, put a 2 by Jump %, a 10 by Change Direction %, 
and a 50 by Cascade %. Then, put a 75 by Scale Tone Pattern % in the Repeat box. Now compose a 
few times and listen as the JAMMER blends all of the variables together to create an original melody 
line.

13. Before continuing on to the next section, put the Low Note back to 65, click on Ok to exit to the main 
screen, click on Solo at the top left of the main screen to turn solo back off and then double left click 
on the Edit Style field of track 3 to get back to the Melody Style screen.
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On to the Final Ending
To create the final ending hold do the following:

1. Set the Punch In and Punch Out to measures 53-56.

2. Click on the Load Style tool to open the Load Band Style dialog box.

3. Select the style:

Jazz Swing Fast    Ending | Piano Simple / Simple Bass (1)

4. Click on OK to load the style.

5. Compose one time to hear the ending chord.

At this point you could load another style to do a band or orchestra hit to stop our tune but that’s rather 
strong for this type of song so let’s use a more subtle type of stop where the drummer does a very short 
roll to stop the song. Place a short fill marker on the last measure (measure 59) and then recompose a 
few times to get a roll you like.
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Other Tips and Hints
Copying Track Styles: When you load a band style, only the tracks that are set to Comp in the Action 
field are setup to create parts in that style. However you can copy the style from any one of those tracks 
to any other track and then start composing on the new track. For example, if you are using a style with a 
sax lead and you want to bring in another instrument to play melodies you can copy the style from the sax 
track to another track and compose a melody on the new track. To copy a track style, select Copy Track 
Style from the Edit menu and then select the source and destination tracks.

Removing Parts From A Style: You can remove any part of any style that is set to Comp in the Action 
field simply by changing the Action field for that track to Eras and then composing again.

Blending Band Styles Together: If you hear components of one band style that you would like to use in 
conjunction with another band style first load the main band style and compose the parts you like. Then 
load the other band style, make a note of the tracks that are on Comp in the Action field that you want to 
use, click on Set All Tracks to Keep under the Util menu, set the tracks that you want to compose back to 
Comp in the Action field, and then compose away.

Getting Takes On Specific Tracks: If you are really into detailing your songs and you are listening 
closely to each track part composed, you can lock down each track individually as they play parts that you 
really like. For example, if the bass player plays a great part that you want to keep, but you want to 
continue composing the piano part, you can put the bass player's track on Keep in the Action field and 
continue to compose, getting new    drums and piano parts while the bass part remains untouched.

Working On A Group Of Tracks: To compose a group of tracks without having to worry about the 
settings of the others, select the desired tracks by clicking on their track number. Make sure the Action 
fields are set to Comp for the selected tracks. Then, hold down the Control key while you click the COMP 
button.

Working On A Single Track: To compose a single track without having to worry about the settings of the 
others, move the Tracks Window cursor to the desired track. Then, hold down the Control key while you 
click the COMP button. Make sure that there are no other tracks selected, or they will be composed 
instead.

Working On Specific Measures: To compose a group of measures that are inside of your current punch 
zone, without having to reset your Punch In or Punch Out Measures, first select the measures. Then 
press the COMP button. Only the selected measures will be composed. This is a good way to "touch-up" 
a small section of your punch zone. Combining this technique with that of composing selected tracks 
allows you "hone in" on small sections of your song, with very little effort on your part.

Use The Undo/Redo Feature: Use the Undo feature to perform back and forth comparisons when 
composing or performing editing operations. For example, compose a part. Then compose again. Now, 
select Undo from the Edit menu. The first part will be restored. After performing an Undo, the Edit menu 
will show Redo. Selecting Redo will, in effect, re-perform the last operation. Go ahead and select Redo. 
Now, the second part is restored. Using this method, you can perform "before and after" comparisons on 
any of the JAMMER’s operations. So, do not be afraid to experiment with the JAMMER. You always have 
the Undo feature to fall back on.

Using The Progression Composer:        If you don’t have a chord progression in mind or you are 
looking for some new chord ideas, you can enable the Progression Composer by right clicking on the 
Progression Composer tool in the top left corner of the screen. Now when you click on COMP, new 
chords will be written to the Measures Window in the punch zone. You can control what type of chords are 
written by left clicking on the Progression Composer tool, and editing the Progression Composer style.
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Patch Table Configuration
To see a list of the available patch table configuration files select Load Patch File from the Devices menu. 
To select a patch table configuration file, move the highlighted bar to the desired filename and then press 
Enter or click on the Ok button. If there is no patch table file which matches your MIDI device then you 
can create one by selecting Edit Patches from the Devices menu. You will then see a full screen of 
instrument patch assignments.

There are 256 available slots in the patch table. Each table entry equates a patch name with a patch 
number. When playback starts the JAMMER will automatically set the patches on each track for you 
according to the values in this table. The patch table is already filled in with the standard patch names. If 
your MIDI devices are not GM or GS compatible then we recommend that you use the patch names 
furnished and just change the patch numbers to match your synthesizer as close as possible. Doing this 
will allow you to have your songs played properly by a number of different synthesizers even though they 
may all have different patching conventions. The quickest and easiest way to get up and running is to set 
just the patch numbers for the instruments used by the JAMMER in the provided mix files.

Acoustic Grand Jazz Electric String Ensemble1

Electric Piano1 Distortion Trumpet

Clavinet Acoustic Bass Synth Brass1

Rock Organ Fingered Bass Alto Sax

Nylon String Slap Bass 1 Synth Square

Steel String Violin Banjo

The JAMMER patch tables are "1 based". In other words, the patch numbers start at 1 and end at 128. 
When entering patch numbers, If your sound module’s patch numbers start at 0, add 1 to the number of 
your sound module’s patch numbers.

To edit a patch number, double click the mouse on the patch name or move the cursor to the patch name 
and press Enter. When you are done, click on the word File at the top left of your screen (or press Alt+F) 
to open the File menu. Then select Save and Exit to save your new patch assignments. The JAMMER will 
open a dialog box allowing you to save your patch table under the name of your choice. After you save 
your patch setup, the JAMMER will remember it's name and will automatically load it the next time you 
start the program.
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Pick a Style, Any Style
  

Now, let’s load a band style and compose 
some music for our introduction. Click on 
the Load Style tool or select Load Style 
from the Styles menu and the JAMMER 
will present you with an alphabetical list of 
the available band style files. Each band 
style file contains a preset group of 
selected musicians on selected tracks who 
are setup to compose parts under that 
style to yield a full band sound.

To hear some music created under a given 
style, select the style using your mouse or 
arrow keys and then click on the Load and 
Compose tool on the right side of the 
dialog box.

Then, the JAMMER will load the style into memory, compose the measures in the punch zone and play 
the measures for you. You can get a good feel for what each style is like by staying in this dialog box, 
highlighting various styles and then clicking the Load and Compose button. There are over 200 different 
band styles from which to choose.

The JAMMER actually improvises to create original parts for you and can come up with many different 
parts under each given style. Some styles are very dynamic and can yield millions of different parts while 
other styles are more groove oriented and yield fewer variations. When previewing styles, go ahead and 
have the JAMMER compose 5 or 10 times to get a good feel what for that style can produce. When 
working on your songs, feel free to compose as many times as you like listening for that special part that 
fits your song just right.

Take a few minutes now before we continue with the tutorial to preview some of the styles. Remember 
you can select the Load and Compose button as many times as you like on the same style to hear 
different parts being created.

When you are done previewing styles for the time, load the band style called:

Jazz Swing Fast Intro | Piano Simple / Simple Bass (1)

Find this style in the list of styles and press Enter or click on the Ok button. The JAMMER will then load 
the style into memory and return you to the main screen. You may find it useful to put a comment in the 
lyrics field of each measure where you start using a different band style letting you know what style you 
used there.
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Previewing Fundamental Styles
First let’s hear just a single fundamental timing style. The easiest way to preview a single fundamental 
style is to double click the left mouse button on the edit field that is next to the fundamental style name. To 
get a feel for previewing fundamental styles do the following:

1. Double right click on the Major Scale edit field at the right of the Melody Style screen. This will place a 
value of 20 in the Major Scale field, making it the only scale choice.

2. Double click the left mouse button on the Slow edit field at the top left of the Melody Style screen. You 
will hear a simple melody being played on the piano which holds its notes rather than cutting them 
short. You can hear more takes under the same settings by double left clicking on the same spot 
again or by clicking on the COMP button at the bottom of the screen. Remember that the JAMMER 
improvises and will play something different each time you compose. Feel free to compose as many 
times as you like in each of these examples.

3. Double left click on Slow Cut and you will hear a simple melody composed that cuts some notes short 
rather than holding them. 

4. Double left click on Blues 8ths and you will hear blues runs being played with a triplet eighth feel.

5. Double left click on Medium and you will hear a triplet 8th feel melody.
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Punching In and Out
One of the main keys to producing good songs is the use of dynamics. For example you may have an 8 
bar verse in a song with a straight drum beat, a bass guitar, and a six string guitar which leads into an 8 
bar refrain where an organ part joins in and the hi hat goes to double time. Then the refrain might lead 
into a 16 bar chorus where the organ drops back out, a synthesizer and a ride cymbal come in, and the 
bass guitar and kick drum change grooves together. These are the types of dynamic parts you can create 
using the automatic punch in and out feature. Listen carefully to some professionally produced songs and 
you'll hear all kinds of production techniques that give the songs texture and life. With a little creativity you 
can create thousands of dynamic parts in the JAMMER simply by deciding who plays what, when, and 
where.

The automatic punch in and out allows you to work on a specific group of measures in your song while 
leaving the rest of the song measures alone. Let’s start by working on the introduction to our example 
song in measures 1-4. To set the punch do the following:

1. Select measures 1-4 by clicking the mouse down on measure 1 and dragging the mouse to measure 
4 before releasing the button. Measures 1-4 should now appear inverted (or black) to show that they 
are selected.

2. Now click the mouse button down anywhere inside of measures 1-4 and drag the measures 
over to the Punch tool and then release the mouse button.

3. Look for the word Loop at the top of the screen to the right of the tape deck icon and make sure 
looping is enabled. You can click on the word Loop to toggle looping on and off. The Loop display should 
read: Loop      001-004. 
The Punch In measure (measure 1) will now have a green arrow under it, the punch out measure 
(measure 4) will have a red arrow under it and the measures in the punch zone (measures 1-4) will have 
their measure numbers displayed in red to let you know they are selected for composing.

Now when you ask the JAMMER to compose some music, it will compose only the measures in the 
punch zone and then play them back in a loop for you to review the new parts. This is the heart of the 
JAMMER's flexibility, as you can work on any section of a song you choose while leaving the rest of the 
song as it is. You can have the JAMMER work on a group of measures or even work on a single measure 
at a time.

You may also set the punch and loop measures by first selecting the desired measures and then clicking 
and holding the left mouse button down on the Punch tool. A fly-out tool bar will appear. By dragging the 
mouse and releasing the mouse button on one of the various tools on the fly-out tool bar you can set the 
punch and loop values, just the punch values, just the loop values, or go directly to the punch dialog box 
and type in values.
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Quick Clicks in the Style Screens
There are four different ways to click the mouse to get quick results while in the style screens of the 
JAMMER. These quick clicks are as follows:

1. Single clicking the left mouse button on a field will move the cursor to that field.

2. Double clicking the left mouse button on a style, transition or scale usage weight field will place a 
weight value of 20 in the field, put a value of 0 in all of the other fields in the same group and then 
compose and start playback. This is a quick and easy way to sample or preview various individual 
styles, transitions, or scales.

3. Single clicking the right mouse button on a field will place a 0 in that field. This is a quick and easy 
way to clear a field or remove it from an existing blend of various individual styles, transitions, or 
scales.

4. Double clicking the right mouse button on a style, transition or scale usage weight field will place a 
weight value of 20 in the field and do nothing more. This is a quick and easy way to place a 20 by a 
field when blending various individual styles, transitions, or scales together.
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Remember to Eat and Get Some Sleep
Now you're ready to create a masterpiece and have a ton of fun at the same time. Just try to remember to 
stop and eat every now and then, and try to get some sleep at least once a day. Have fun jammin.

If you own the Professional version of the JAMMER, you may proceed to Advanced Tutorial. Or, if you do 
not own the JAMMER professional, and wish to find out what extra features it offers, you may want to look 
through the Advanced Tutorial.



Reviewing and Saving Your Work
To review all of the parts that you have created, simply click on the word Loop at the top of your screen 
until it says Loop Off. You can then put the playback cursor anywhere you like and click on the play 
button. To start playback from the beginning of the song click on the rewind button twice and then the play 
button. Clicking on the rewind button once will rewind to the Loop From measure if you are past it. The 
second click on the rewind button will rewind back to the beginning of the song.

As with any computer program, save your work frequently. To save your song, select Save Song As from 
the File menu. The JAMMER will then open the Save Song dialog box allowing you to save the song 
under the name of your choice. If you want to save it as a Standard MIDI File then select Export to MIDI 
File from the File menu and the JAMMER will open a dialog box allowing to save your song as a Standard 
MIDI File with the name of your choice. Note: Whether or not you export your song as a Standard MIDI 
File (SMF), you should ALWAYS save it as a .CMP file using the Save or Save As selection under the File 
menu since this format saves your entire JAMMER working environment, your musical tracks and your 
chord progression.
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Selecting MIDI Devices
The JAMMER will try to establish the MIDI devices that you plan to use. First, you will be prompted for the 
output port that you want to use in the JAMMER.

Select the port you want the JAMMER to use for playing your music and then press Enter or click on the 
Ok button. The JAMMER will then prompt you for the input port that you wish to use.

Select the port you want the JAMMER to use for recording your live playing and then press Enter or click 
on the Ok button. If you do not have a MIDI input device then select None.
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Setting the Tempo
When you load a style in the JAMMER, the tempo is automatically set to the tempo that the style was 
designed for. Changing the tempo too dramatically can make the style sound unreal or awkward. If you 
want to make a moderate adjustment to the tempo, start playback and then click on the word Tempo at 
the top right of the main screen. If you make a tempo adjustment like this, then you need to make sure 
you put an X by Exclude Tempo in the Load Band Style dialog so that the JAMMER will not set your 
tempo for you anymore. As you load different styles to use in your song, it is recommended that you use 
styles of the same relative tempo (Slow, Medium, Upbeat, Fast) as the one you started with since styles 
are tempo dependent. In other words don’t create a verse using a Jazz Swing Slow type of style and then 
try to use a Jazz Swing Fast type of style for the chorus. But of course, you are free to experiment.
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Starting a New Song
Now you're ready to build a song. Set your active window to the Tracks Window and then select Tile from 
the Window menu. You should now see the Tracks Window displayed above the Measures Window in the 
tiled format. 

You can build songs in the JAMMER in a variety of ways. One method is to add enough measures for the 
whole song, type in all the chords to the song and then compose the individual pieces of the song using 
the styles of your choosing. This method works well if the song is already written and you know all the 
chords, parts and arrangement ahead of time. Another method is to build your song one part at a time 
letting the creative process take you where it will. This method works well when you are creating an 
original song and are starting from scratch. For the purpose of this tutorial we will use the first method as 
though we were doing a remake of a popular song, however the things you learn to do here can be easily 
applied to the part by part method of building originals. To start a new song do the following:

1. Clear out the current song by selecting New from the File    menu. The Measures Window will go 
blank.

2. Click on the Add Measures tool or select Add Measures from the Tools menu and the JAMMER will 
open the Add Measures dialog box.

3. Select the time signature and key signature for the measures you are adding. (Use 4/4 and Bb 
Major for this example)
4. Enter the number of measures you wish to add. (Use 100 for this example)
5. Remove the check mark by the Insert Drum Fills check box. (You will learn how to add your own drum 

fills in this tutorial)

6. Now press Enter or click on Ok and the JAMMER will add the new empty measures to the Measures 
Window.

Now you have 32 blank measures ready for you to add chords. Set the active window to the Measures 
Window by typing Ctrl+W, or by clicking in the measure window or on the Swap Window tool and then 
press the number '4’ key to display four measures per line.
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The Sky's the Limit
The JAMMER is a product which gives you a large amount of control in creating original parts and lets 
you get involved in producing songs with great detail. The example song we built here is just one of a 
billion different ways you can produce songs with the JAMMER. The more ideas and work you put into a 
song the more you will get out of the JAMMER. If the JAMMER automatically produced your whole song 
from beginning to end with the touch of a single key then it wouldn't really be "your" song and you'd 
probably get bored in a hurry. So take advantage of the flexibility the JAMMER has to offer and use it as a 
tool to help you realize your creative musical potential.
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Tracks Window
The Tracks Window allows you to scroll through, view and edit the settings for the 256 MIDI event tracks. 
The JAMMER is setup with particular instruments on tracks 1-27 and particular drums on tracks 28-55. It 
is best to use this format since the band style files that come with the JAMMER use this format. You 
should always leave the drums on tracks 28-55 since they are a special case in MIDI and are treated 
differently by the JAMMER.

You can go directly to the drum tracks 
from anywhere in the JAMMER by 
clicking on the Drum Set tool on the 
top tool bar.

You can also go quickly to any instrument track from anywhere in the JAMMER by clicking on the tool for 
that instrument.

Clicking on the Bass Guitar tool is an 
easy way to get back to the first track 
in the Tracks Window since the bass 
is always on track 1. Go ahead and 
click on the Bass Guitar tool now to 
take you back to first track.

The tracks you see highlighted are 
tracks with MIDI events on them. If 
you want to see all of your tracks that 
have events grouped together, the 
JAMMER can pack the tracks for you. 
Click the Pack tool on the side tool 
bar to the left of the Tracks Window 
and the JAMMER will display the 
Tracks Window in packed mode.

Now you can see all active instrument tracks and the drums tracks together. The drum tracks are 
displayed in blue to make it easy to tell them apart from the instrument tracks. Click on the Pack tool 
again and the JAMMER will return to the unpacked tracks view.
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Typing in Chords
Before letting the JAMMER compose some music we need to enter a chord progression for the musicians 
to follow. Let’s create a simple jazz swing progression for an example of how to build a song in the 
JAMMER. To enter a chord do the following:

1. Using the mouse or arrow keys, move the cursor in the Measures Window to the place you want to 
enter or edit a chord. Move to the first position in measure 1 for this example.

2. Type in the chord Bbmaj9 and then press the Enter key.

Now that you know how to enter chords put a Gm7 in the beginning of measure 2, a Cm9 in measure 3 
and an F7#5 in measure 4. You can move from measure to measure using the mouse or by holding down 
the Ctrl key and using the arrow keys. You can move an eighth note at a time in a measure by using the 
right and left arrow keys. To edit an existing chord, move to the chord and press Enter or double click the 
left mouse button on the chord and an edit field will appear allowing you to edit the chord. Press the Enter 
key when you are through editing.
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Using Custom Timing Patterns
There are four custom timing patterns available to the Melody Composer. These are shown on the bottom 
portion of the style screen.

The custom patterns allow you to set the note timing, note values, and velocities of riffs to be composed 
by the JAMMER. The custom patterns you type in can be blended with the fundamental patterns provided 
for you in the top left section of the screen. To enable a custom pattern, put a usage weight by it just like 
you would for a fundamental style.
Each character position in a custom pattern represents a 48th note. Therefore, 3 character positions 
make up a sixteenth note, 4 make up a triplet eighth, 6 make up an eighth, and 12 make up a quarter 
note. Each custom pattern can be up to 8 quarter notes long. Custom patterns are hooked together 
repeatedly to build a larger pattern which is then used to compose a part.

The following table shows some commonly used note durations:

Pattern Length Note Type

*----------- 12 Quarter

*-------- 9 Dotted 8th

*----- 6 8th

*--- 4 Triplet 8th

*-- 3 16th

*- 2 Triplet 16th

* 1 48th

The '#', '*', and '+' characters are used to indicate that a wild card note is to be played at that point. Wild 
card notes are notes where the JAMMER is allowed to choose the note value (frequency). The '#' 
character represents a heavy velocity note, the '*' character represents a medium velocity note, and the 
'+' character represents a lightly played note. The velocity to be used for each of these is defined in the 
Melody Control screen. You can also designate certain chord tones to be played by using the numbers 
1,2,3,4,5,6,7,8, where 1 represents the tonic, 2 represents the second, 3 the third, and so on. The 
JAMMER will perform corrections to insure that the proper 3rd (major or minor), 6th, 7th, etc. will be used 
over the various types of chords (major, minor, dominant and dominant altered). For the complete 
reference of designated note types, search for Designated Notes in the on-line help file (Choose Search 
For Help from the Help menu).

Dashes following a '#', '*', '+' , or scale tone character indicate that the note is being held. Spaces in a 
custom pattern represent silence. Since spaces can be on the end of a pattern, to see where a pattern 
really ends, place your cursor in the custom pattern field and press the End key on your computer 
keyboard keypad. The cursor will then move to the end of the pattern. To get a feel for how custom 
patterns work do the following:

1. Double left click on usage weight field to the left of the first (top) custom pattern. The JAMMER will 
now play the major scale up and down using solid triplet 8ths.

2. Double left click on usage weight field to the left of the second custom pattern. The JAMMER will now 
play the major scale up and down using triplet 8ths again but with the last three triplets of each six 



being played staccato (with a short duration).

3. Double left click on usage weight field to the left of the third custom pattern. The JAMMER will now 
play the major scale up and down using triplet 8ths with some light triplet sixteenths at the end of the 
pattern.

4. Double left click on usage weight field to the left of the fourth custom pattern. The JAMMER will now 
play the octave tonic, seventh and fifth of the chord over which it is playing.

There are millions of different patterns you can use to create original music or to recreate popular songs. 
You can even blend wild cards with designated notes to give variation to a known riff. And of course you 
can blend these patterns together with one another and with the fundamental styles above, using the 
weights of your choice. The possibilities are in the billions!
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The Compose button

Clicking on this button or pressing F7 will cause the JAMMER to compose parts in the measures 
designated by the Punch In and Punch Out values on all tracks where the Action field is set to COMP.



The Fast Forward button

Clicking on this button or pressing F4 will fast forward to the Loop From measure or to the end of the song 
(which ever comes first).



The Play button

Clicking on this button, or pressing F2 or the spacebar will start playback from the current measure. You 
may also click on this button to stop playback.



The Record button

Clicking on this button or pressing F5 will start playback from two measures before the Punch In measure 
and will start actually recording notes starting at the Punch In measure.



The Replay button

Clicking on this button or pressing F6 will move the cursor to the Loop From measure and then start 
playback.



The Rewind button 

Clicking on this button or pressing F3 will rewind to the Loop From measure or to the beginning of the 
song (which ever comes first).



The Stop button

Clicking on this button or pressing the space bar while playback is active will stop playback.






